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Course Overview   
This course will cover how to reference older Survey dgn files created in V8i as well as new 
CONNECT Edition survey files.  The course will also teach different techniques to attach Imagery 
and LiDAR data. The CTDOT’s  default Geographic Coordinate System (GCS) is NAD 1983 State 
Plane Connecticut with a North American Vertical Datum of 1988. There are cases in which the 
Survey was created using different datums, this course will step through the process of 
reprojecting imported data to line up with other datums. 

Skills Taught 
• Referencing Survey DGN Files 
• Attaching Imagery 
• Creating Raster Container Files 
• Creating an existing Terrain from Lidar 
• Re-projecting DGN files 

Exercises and Available Working Files 
Exercise 1 – Referencing the Survey File 
…\Active_Survey\SV_XX_0154-0128_Westbrook_ORD.dgn 

Exercise 2 – Referencing Old V8i Files 
…\Active_Survey\SV_XX_0098_0103_Branford_GRN.dgn 
…\Active_Survey\SV_XX_0098_0103_Branford_ORD_Terrain.dgn 

Exercise 3 – Working with Datums 
…\Active_Survey\SV_XX_0107_0108_Oxford_GRN.dgn 
…\Active_Survey\SV_XX_0107_0108_Oxford_ORD_Terrain.dgn 

Exercise 4 – Attaching Imagery 
…\Share\Oxford\*.sid 

Exercise 5 – Creating a Terrain from LiDAR Data 
…\Share\Oxford\*.las 

Exercise 6 – Connecting to GIS Data 
None 

Exercise 7 – Skills Review 
…\Active_Survey\SV_XX_047_0122_Ellington_NAV83_V29_3.grn 
…\Active_Survey\SV_XX_047_0122_Ellington_NAV83_V29_4.grn 
…\Active_Survey\SV_XX_047_0122_Ellington_NAV83_V29_5.grn 
…\Active_Survey\SV_XX_047_0122_Ellington_NAV83_V29_6.grn 
…\Active_Survey\SV_XX_047_0122_Ellington_NAV83_V29_ORD_Terrain.dgn 
…\Share\Ellington\*.sid 
…\Share\Ellington\*.las 
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Introduction 
This volume will focus on the base set up for the civil applications OpenRoads Designer and 
OpenBridge Modeler. All civil engineers should have a solid knowledge base of Geographic 
Coordinate Systems and understand the uses of data acquisition for existing conditions. These 
workflows will not document each tool that is available on the interface. See the online help for 
commands not detailed in this document. 
 
Survey dgn files that have been through the QC process are available for referencing in the 
Active_Survey folder in each project.  Protecting the integrity of the survey information has 
always been a concern for CTDOT’s Survey personnel. Under no circumstances shall design 
personnel copy the survey files out of the Active_Survey folder into their folder in the effort to 
edit the survey data contained in the Survey field book/terrain design file(s). The accuracy of 
the Survey information is the responsibility of the survey offices and therefore the original 
survey information shall not be edited by design personnel. If changes need to be made to the 
survey files, these changes shall be coordinated with the originator (Central and District 
Survey) of the survey data. 

Terrain Creation Methods  

The three methods used for creating an existing terrain in a Survey design file are as 
follows: 

• Location Survey post-processed field data (only completed by the Survey Unit) 
• InRoads DTM Conversion (only completed by the Survey Unit) 
• LiDAR Data (can be created by survey or design).  

Design may use extracted LiDAR for use with non-contract files. A use case maybe to 
determine drainage areas that expand outside of the supplied survey. 
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Official Survey Deliverables 

New Terrain processed with ORD fieldbook 
When a new OpenRoads Location Survey is requested, the Survey Unit will use OpenRoads 
Designer to create a fieldbook and import field data. Survey information processed with the 
ORD Survey tools are written directly to the DGN file.  Both the fieldbook and terrain model 
are embedded within the ORD design file. 

This survey file is in the CTDOT WorkSet Design folder Active_Survey. The Survey DGN File 
will contain several different Models each with distinct information and uses: 

3D Design Model Existing Ground Survey Existing Survey Feature, Terrain 
3D Design Model Utilities Borings, Test Pits, Utility as-builts 
3D Design Model Bridge Deck Existing bridge deck, Terrain 
3D Design Model Hydraulic Data Hydraulic Section, FEMA floodplain data 
2D Design Model Boundary ROW, Property Info, Annotation 
Drawing Model Annotation Existing survey labels, Map Features 
Sheet Model Title Block Plot border, Ties Boxes and Title Block 

 
Figure 1 - Existing Survey DGN Models 

Geo-Coordination 

Having the correct geographic setting on your CAD file provides capabilities such as: 
• Applying a background map to the view. 
• Referencing other geo-located designs and raster data. 
• Displaying geographic latitude and longitude. 
• Entering latitude and longitude data. 
• Interfacing with a Global Positioning System device to correlate your physical 

position with the design on a mobile computer. 
• Exporting to Google Earth. 

For more information on the National Geodetic Survey please visit:  
http://www.ngs.noaa.gov/faq.shtml#WhatNAD 

http://www.ngs.noaa.gov/faq.shtml#WhatNAD
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Exercise 1 – Referencing the Survey File 
This exercise instructs users how to create a base model design file for a project. Base model files 
will reside within the project folder structure the ...\Discipline Folder\Base_Models folder.  

1.1 File Creation 

Before attempting to open or create DGN files users should make sure the following is in place: 
• The CTDOT CONNECT DDE synced through SharePoint 
• The COMPASS (Training) Project Synced 

1. Launch the Application.  On your desktop double click on the Accounting Icon. 

 
Figure 2 - CTDOT CAD Accounting Icon  

2. On the CTDOT Accounting Menu there will be several applications to pick. In the Run 
Program field select the needed program Compass OpenBridge CE or Compass 
OpenRoads CE, for the Available Account select OVERHEAD for training proposes. Click on 
the Start button to load the program. 

   
Figure 3 - CTDOT CAD Account Dialog Box 
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3. After launching the program, a Welcome Screen for OpenRoads Designer will 
appear.  OpenRoads users will continue to Step 4.    
 
For OpenBridge Designer a home dialog box for open. OpenBridge users will need to 
complete a. and b. below before moving on to Step 3.  
a. On the OpenBridge Designer Home dialog box select New to create a new OBDX file in 

your C or D drive. Name the file with your initials and Training. 
(example: ABC_TRAINING.obdx).  
 

 

Figure 4 - OpenBridge Designer Open Screen 

b. On the left side menu unsure that Standalone has been selected (not BIM Workflow). 
Select or create a New Group to expose the OpenBridge Modeler icon. On the left menu 
make sure you a have the Group selected not a DGN file. After selecting the Group click 
on the OpenBridge Modeler icon. 

  
Figure 5 - OpenBridge Designer Open DGN 



VOLUME 2 - Working with Existing Data 

8 
 

4. Ensure you are using the Custom Configuration and CT_WorkSpace, then select the 
relevant WorkSet (Training WorkSets start with 9999_0001, select the # that you were 
assigned) and Role. The example below shows the options available in OpenRoads 
Designer, OpenBridge, will look similar. The WorkSets listed correspond to project numbers 
and will be the same for all products. 

5. Select the New File icon. 

 
Figure 6 - OpenRoads Start Screen  

6. From the New dialog box, Save in: browse to the proper discipline folder and enter the File 
Name: 

HW_CB_1234_1234_Westbrook.dgn  or SB_CB_1234_1234_Westbrook.dgn 

7. click the Browse button to select the proper seed file. See below for each application's seed 
file locations. 
ORD: CT_Configuration\Organization\Seed\Road\Seed2D - CT RoadDesign.dgn 
or 
OBM: CT_Configuration\Organization\Seed\Bridge\Seed3D - CT BridgeDesign.dgn 

8. Follow the prompts to create the file. 

 
Figure 7 - New File 
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1.2 Reference Attachments 
References are used to display the contents of another DGN file within the current ORD and 
OBM models. The Home tab in each Workflow contains the reference tools as shown below. 
This is no different for existing data, terrains and survey topo will be referenced into design 
models. 

 
Figure 8 - Attach Reference 

1. Select the Reference tool.  

Browse to attach: Active_Survey\SV_XX_0154-0128_Westbrook_ORD.dgn  

On the Reference Attachment Properties select: 
Model: Existing Ground Survey 
Orientation: Coincident World 
Nested Attachments: No Nesting 

2. Repeat Step 2 and reference in the Annotation, Bridge Deck and Boundary Models.  

3. Click Fit View in the view window.  

4. Double-check that the survey ground file came in 
at the correct location. Zoom to a coordinate grid 
cross and Intercept Snap to it, the XY-axis below 
the view window should display the same numbers 
as the northing and easting of the coordinate grid 
cross. 

 

Figure 9 – Check Northing and Easting 
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5. Right Click Hold in the view and select View Control / Ref Adjust Colors.  This will dither out 
the references, so your design pops out front. 

 
Figure 10 Adjust Reference File Color using Right Click Menu 

6. To adjust back open the References dialog box, select Properties > Adjust Colors… and 
slide Value and Saturation to 100. 

 
Figure 11 Adjust Reference File Color in Refences Dialog Box 

7. Turn off levels as needed.  Review the file and Save Settings. 
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1.3 Terrain Models 
Terrain models generated by OpenRoads Survey are stored in the design file as a Terrain 
Model element type. The terrain model can be accessed by design personnel by attaching the 
survey design file as a reference attachment. ThIS was done in the steps above when the 
Existing Ground Survey model was referenced in. 

1.3.1 Defining the Active Terrain 

After attaching the survey design file containing the terrain model element, it is normal 
practice to set this terrain model as the “Active Terrain”.  The active terrain model is used to 
define the existing ground for profiles and cross sections.  
When the terrain is activated, the software will automatically create a 3D model in the 
active design file. This 3D model is attached as a self-reference to the active file.  

1. Use the Element Selection tool to select the terrain boundary, Activate the terrain by 
clicking on the terrain boundary, hover over the boundary and from the pop-up menu 
select/click the Set Terrain Active tool (Hint for this survey select the most western edge 
of the terrain). The command can also be selected from the Terrain tab Active > Set 
Active.  Select the terrain model when prompted. 

 
Figure 12 - Set as Active Terrain 

2. Open the Models dialog box and notice a 3D Model Space has been created. 
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1.3.2 Terrain Models Display Settings 

The display of the terrain model is controlled by the feature definition that is assigned in the 
design file that contains the terrain element. In the example above, the terrain is displayed 
using the E_TERR_Ground feature definition. 
 
The terrain display can be defined uniquely for the active file as follows: 
The properties dialog appears as a pop-up dialog as shown below. Since the terrain model 
is contained in a reference attachment, all the fields are ghosted and cannot be edited. The 
user may wish to override the assigned feature definition to turn on/off contours and 
triangles or change the contour interval settings. This is accomplished by setting the 
Override Symbology option to Yes to allow editing the terrain model properties. After setting 
the Override Symbology setting to Yes, the display of the terrain features can be toggled 
on/off using the options shown on the right for turning on/off contours, triangles, etc. 

1. Use the Element Selection tool to select the Existing Ground Survey terrain boundary, 
allow the cursor to rest over the terrain element. The menu shown below appears. 
Choose Properties, and a popup will appear. This can also be seen if the Properties 
dialog box is docked. 

2. Set the override symbology to Yes. Then to turn off and on the Major and Minor 
contours and Triangles.  Watch the view display as each property is selected. 

3. Leave it so the Contours are on, but the Terrain is off. 

4. Review the file and Save Settings. 

 
Figure 13 - Override Symbology    
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1.3.3 Point Features 

When survey files are imported and processed, each field shot is stored as a Point Feature 
in a Field Book which is embedded in the design file. For example, the field code “DT” is 
included in the “e_TREEDC__Deciduous Tree” feature definition and is used to designate a 
Deciduous Tree. When survey data is processed, the tree symbology is generated in the 
design file view using a CTDOT standard cell element as shown: 

 
Figure 14 - Point Symbology 

The information for an individual point can also be reviewed as follows:  
1. From the Home tab, choose the Element Selection command. 

2. Float the cursor over a referenced survey point and allow the cursor to rest over the 
element. 

3. A pop-up dialog will appear showing the survey information for the Point Feature. 

 
Figure 15 - Point Feature Information 
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1.3.4 Linear Features 

A series of survey points representing curvilinear features can be connected as a Linear 
Feature. With the Element Selection tool active, float the cursor over the referenced linear 
feature, and a pop-up menu will open with information about the Linear Feature. 

1. From the Home tab, choose the Element Selection command. 

2. Float the cursor over a referenced survey line and allow the cursor to rest over the 
element. 

3. A pop-up dialog will appear showing the survey information for the Point Feature. 

 
Figure 16 - Linear Feature Information 
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1.3.5 Existing Survey Levels 

The CTDOT CADD Standards include MicroStation levels that are specific to survey 
information. These levels are grouped in the level library using the prefix “E_”. There are 
survey levels for features as well as annotation: 

1. Open Level Display and click on the Existing Ground Reference Model 

2. Sort By Used, explore and become familiar with the groupings.  

 
Figure 17 - Survey Feature Levels 

3. Click on the Annotation Model and notice the E_Annot grouping. 

 
Figure 18 - Survey Annotation Levels 
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Exercise 2 – Referencing Old V8i Files 
The Working Units of DGN files changed with CONNECT Edition.  There will be times old files created 
in V8i will need to be reference.  This Exercise will detail the procedure to get the files to line up 
geospatially. 

2.1 File Creation 

1. Select New File to create a new file. From the New dialog box, browse to the proper 
discipline folder and enter File Name: 

HW_CB_1234_1234_Branford.dgn  or SB_CB_1234_1234_Branford.dgn 

2. On the New dialog box click the Browse button to select the proper seed file. See below for 
each application's seed file locations. 
ORD: CT_Configuration\Organization\Seed\Road\Seed2D - CT RoadDesign.dgn 
or 
OBM: CT_Configuration\Organization\Seed\Bridge\Seed3D - CT BridgeDesign.dgn 

3. Follow the prompts to create the file. 

 
Figure 19- New File 
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2.2 Reference Attachments 

In this portion of the exercise, you will be referencing two files. 

• The Ground Topo design file previously created using V8i. Sometimes you will have 
several ground files and on very old files the extensions maybe .grn. 

• The ORD Terrain survey file, this file was created by importing an old V8i InRoads DTM 

1. Select the Reference tool. 

Browse to attach: Active_Survey\SV_XX_0098_0103_Branford_GRN.dgn 

On the Reference Attachment Properties select: 
Model: 3D Design 
Orientation: Coincident World 
Nested Attachments: No Nesting 

2. Click Fit View in the view window. Double-check that the survey ground file came in at the 
correct location. Zoom to a coordinate grid cross and snap to it, the XY-axis,  

3. Notice the coordinates do no match up. 

4. In the References dialog box change True Scale to off and the scale to 1 to 1. 

5. Fit the view and re-check the coordinates, they should now line up. 

 
Figure 20 - Reference file Settings 

6. Select the Reference tool.  Browse to attach: 
Active_Survey\ SV_XX_0098_0103_Branford_ORD_Terrain.dgn 

On the Reference Attachment Properties select: 
Model: Default 
Orientation: Coincident World 
Nested Attachments: No Nesting 
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7. Click Fit View in the view window. Double-check that the survey ground file came in at the 
correct location. Zoom to a coordinate grid cross and snap to it, the XY-axis, the 
MicroStation command window should display the same numbers as the northing and 
easting of the coordinate grid cross. 

8. Review the file and Save Settings 

2.3 Line Style Scale 

With some old files the Line Style Scale may not come through the correct size when 
referencing.  The Line Style may come through so small they view as a solid line. This can be 
adjusted in the Attachment Properties, set: 

Global LineStyle Scale : Reference 

 
Figure 21 - Set Global LineStyle Scale 
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Exercise 3 – Working with Datums 

3.1 File Creation 
CONNECT Edition design files contain Geo-Coordination features which allow users to specify 
the position of the design contents on the Earth's surface. Once that position is established, the 
design can be easily coordinated with other data for which the geographic location is 
known. The seed files in the Discipline folders have been assigned a default Geographic 
Coordinate System (GCS) of NAD 1983 State Plane Connecticut with a North American Vertical 
Datum of 1988 to allow interaction with geospatial applications. This GCS has also been 
applied to each view as an Auxiliary Coordinate System (ACS). Seed files of different Datums 
are available in the GCS folder for use with odd cases. Designers should first consult with the 
Survey Unit to obtain the correct datums (NAD and NAVD). This coordinate information can 
also be found in the Survey dgn title block notes, users can open the survey files read only to 
view this information. 

1. Select New File to create a new file. From the New dialog box, browse to the proper 
discipline folder and enter the proper File Name: 

HW_CB_1234_1234_Oxford.dgn or SB_CB_1234_1234_Oxford.dgn 

2. On the New dialog box click the Browse button and select the following Seed File: 
ORD: CT_Configuration\Organization\Seed\GCS\2D_ NAD83FT_NAVD88.dgn 
or 
OBM: CT_Configuration\Organization\Seed\GCS\3D_ NAD83FT_NAVD88.dgn 

3. Follow the prompts to create the file. 

 
Figure 22 – New File 
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3.2 Reference Attachments 

In this portion of the exercise, you will be referencing two files. 

• The Ground Topo design file previously created using V8i. Sometimes you will have 
several ground files and on very old files the extensions maybe .grn. 

• The ORD Terrain survey file, this file was created by importing an old V8i InRoads DTM 

1. Select the Reference tool. 

Browse to attach: Active_Survey\ SV_XX_0107_0108_Oxford _GRN.dgn 

On the Reference Attachment Properties select 
Model: 3D Design 
Orientation: Coincident World 
Nested Attachments: No Nesting 

2. Click Fit View in the view window. Double-check that the survey ground file came in at the 
correct location. Zoom to a coordinate grid cross and snap to it, the XY-axis,  

3. Notice the coordinates do no match up. 

4. In the References dialog box change True Scale to off and the scale to 1 to 1. 

5. Fit the view and re-check the coordinates, they should now line up. 

 
Figure 23 - Reference file Settings 

6. Select the Reference tool. 
Browse to attach: Active_Survey\ SV_XX_0107_0108_Oxford_ ORD_Terrain.dgn 

On the Reference Attachment Properties select: 
Model: Default 
Orientation: Coincident 
Nested Attachments: No Nesting 
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3.3 Geographic Coordinate Systems 
Let’s explore the Geographic tools available with the OpenX applications 

1. Use the Intersect Snap, Place Line command and place a line from one Northing and 
Easting Tick Mark to another. 

 
Figure 24 - Place Line from Tic Marks 

2. On the Utilities tab in in the Geographic section select Coordinate System. 

 
Figure 25 - Coordinate System Tools 

3. Notice the Geographic Coordinate System dialog box information, this file uses NAD83 and 
NGVD88. 

 
Figure 26 - Coordinate System Settings 
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4. In the View window, zoom into the Survey Title Block and look for the Datum Information to 
check it against the dialog box. Notice they do not match. There are two tools that can be 
used to rectify this situation. Users can get the correct Coordinate System by using the 
From Library or From File tools. 

 
Figure 27 - Survey N.A.D. and NGVD Notes 

a. A library of predefined Geographic Coordinate Systems (GCS) is available in CONNECT. 
Select the From Library icon to see the list of available Datums. Browse to 
Library/Projected (northing, easting, …)/North America/United States of 
America/Connecticut, notice the available datums.  This method can be confusing as 
there are a lot of options. Click Cancel. 

 
Figure 28 – Select Coordinate System From Library Icon 

 
Figure 29 – Select Coordinate System From Library 
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b. Rather than selecting a GCS from this overwhelming library list, AEC provides seed files 
in the delivered CONNECT Workspace that can be used as a Geographic Coordinate 
System Source. These files can be accessed by selecting the From File tool on the 
Geographic Coordinate System Toolbox.  The tool will apply the GCS from the selected 
source to the active design file.   

 
Figure 30 – Select Coordinate System From File icon 

Select From File, browse to and select Open: 
CT_Configuration\Organization\Seed\GCS\3D_NAD27FT_NAVD29.dgn 

8. The Geographic Coordinate System Changed dialog box will appear.  There are two 
options. 

 
Figure 31 - Geographic Coordinate System Changed Dialog Box 

a. First, we will see what Reproject the Data to the Geographic Coordinate System does 
to the line placed in step one. Select Fit View, this is not the desired option as it no 
longer lines up with the Survey.  Select undo to reverse this setting and re-select Fit 
View. 

 
Figure 32 - Reproject the Data to the Geographic Coordinate System 
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b. Select the From File tool again but this time select Correcting the Geographic 
Coordinate System – do not reproject the data.  

Notes: 
• Notice the line does not move and the Coordinates still match.  Zoom to one of the 

lines that was placed on the coordinate grid cross and snap to it, compare the 
graphical text with the XY-axis output. The same northing and easting numbers 
appear. 

• If you have other Models in the file, for example a 3D Model that was created during 
the Corridor Modeling procedure you will need to repeat step 5b. 

 
Figure 33 - Coordinates Tic Marks Match 
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9. Notice the Survey Notes Block and the Datum now match.  

 
Figure 34 - Coordinate System Check 

7. Select Save Settings 
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Exercise 4 – Attaching Imagery 
There are two ways to view areal imagery in a DGN file. 
1. Through the View as a background map 
2. Attaching a raster image 

4.1 Select View Background Map 
1. Open the File from Exercise 3.  

HW_CB_1234_1234_Oxford.dgn or SB_CB_1234_1234_Oxford.dgn 
2. Open the file for exercise 3, On the View window icon click on Select Background Map. 

 
Figure 35 - View Background icon 

3. In the Map Type pull down select Background Map Type. Select Road, Aerial, or Hybrid. 
 

 
Figure 36 - Background Map Type Pick List 

       
Figure 37 - Background Map Views 
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4.2 Connecting to Imagery on a Web Map Server (WMS) 
1. Open the File from Exercise 3.  

HW_CB_1234_1234_Oxford.dgn or SB_CB_1234_1234_Oxford.dgn 

2. Open the file for exercise 3, Turn off the background map. 

3. Open the Raster Manager, click on File > Attach > WMS 

4. Browse to CT_Configuration\Organization\Seed\GCS\ 

5. Double click on Ortho_2023_EPSG_2234.xwms to open, select Attach 

Note: This will load an image of the entire state.  It may take some time for this image to 
come in to view as it is bringing a large amount of data. The view will be slow to entirely 
update, because of this attaching individual SID files may be more desirable. There are 
other xwms files available for use in this folder as well. 

 
Figure 38 - Attach Raster Options 
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4.3 Attaching Imagery from Raster Files 
A DGN file will be used as a container for the Orthophotography raster attachments. No other 
items (line work, cells, text, etc…) shall be added to this file accept for the raster 
attachments.  This container DGN file can be referenced into other Design, Drawing, and Sheet 
Models as needed. Following this simple procedure will be extremely helpful to other units that 
are referencing your files. There have been several help inquiries on raster referencing through 
the years going back to V8i and continuing in CONNECT Edition. AEC has found that setting up 
your raster’s in a separate dgn has solved publishing, printing and other downstream issues. 

In this exorcise we will be attaching information from UCONN: 
http://www.cteco.uconn.edu/download.htm 

• CONNECT Edition Products are now compatible with 4 band orthoimage (MrSID4). 
• UCONN uses NAD 83. The DGN container file will be NAD 83 and will be projected as 

needed in your files used for design and layout.  
• The downloaded data will be in a Zip file and should be extracted to the Share folder in 

your Workset. Typically, there are two types of Images available depending on the year 
selected on UCONN’s site, Tiffs and SIDs.  It’s important that all the files in the Zip be 
copied into the Share folder together. 

1. In File Explorer browse to your project’s Share folder.  Click on the Oxford Folder.  Notice the 
Downloaded data from UCONN’s site. 

2. In CAD create a 2D DGN file using a 2D Seed file and use it as a container for the 
Orthophotography raster attachments and store it in the Share folder. 

HW_CB_1234_1234 _Oxford_Raster_Container.dgn  

Use the seed file: 
CT_Configuration\Organization\Seed\GSC\2D_NAD83FT_NAVD88.dgn 

3. After the file is created check to make sure the CT NAD 83 Geospatial Header is attached. 

 
Figure 39 - Coordinate System Settings 

http://www.cteco.uconn.edu/download.htm
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4. Now you will need to check your user settings. Select File > Settings > User > Preferences. 

5. On the Preferences Dialog box locate and select Raster Manager and under Georeference 
check the following: 
Sister File Settings: 
Use Sister Georeferenced File is toggled on. 
Save Location Information is toggled on. 
 
Default Unit Settings: 
Sister File: 1 Unit = 1 US Survey Feet 
Raster file: 1 Unit = 1 Us Survey Feet 
Use Unit Definition Geokey if Present (override PCS unit) is toggle on. 

 
Figure 40-  User Preferences Raster Managers Settings 

6. Click OK. 

7. Select the Home tab and hold down the Attach Tools icon, select Raster Manager. 

 
Figure 41 - Raster Manager tool 
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8. In the Raster Manager select File / Attach / Raster and browse to Share/Oxford attach the 
.tif or the sid file. 

9. On the Raster Attach Options dialog box under Geometry select Attachment. Select the 
Attach button to accept. 

 
Figure 42 - Raster Manager Attachment Settings 

10. Select Fit, to bring the photo to the center of the view and Save Settings. 

 
Figure 43 - View of Raster Image 
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11. Open the File from Exercise 3.  
HW_CB_1234_1234_Oxford.dgn 
or 
SB_CB_1234_1234_Oxford.dgn 

12. Turn off the background map and the in the Raster Manager turn off the WMS in View 1. 

13. Reference this file in using Geograpghic - reprojected. Notice the reference lines up with 
the NAD 27 Survey File. 

 
Figure 44 - Reference Geographic Reprojected 
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Exercise 5  - Creating a Terrain from LiDAR Data 
 

Statewide LiDAR can be found on the UCONN/CT ECO Website. CONNECT Edition Products are now 
compatible the LAS data. 

For information please visit: 
http://www.cteco.uconn.edu/download.htm 

• UCONN uses NAD 83. The DGN container file will be NAD 83 and will be projected as needed 
in your files used for design and layout.  

• The downloaded data will be in a Zip file and should be extracted to the Share folder in your 
Workset. 

This Module will introduce two ways to import TOPO Data: 
• Terrain from LAS File 
• Terrain from Esri 

 

http://www.cteco.uconn.edu/download.htm
https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-002---introduction-to-openroads-designer/creating-a-terrain-from-lidar-data?language=en_US#Terrain%20from%20Esri
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5.1 Terrain from LAS File 

5.1.1 Import with Filtering 

1. In CAD create a 3D DGN file using a 3D Seed file and use it as a container for the LAS 
Terrain and store it in the Share folder. 

HW_CB_1234_1234 _Oxford_TerrainFromLAS.dgn 

Use the seed file: 
CT_Configuration\Organization\Seed\GSC\3D_NAD83FT_NAVD88.dgn 

 
Figure 45 - Create New File 

2. Check to make sure the CT NAD 83 / NAVD88 Geospatial Header is attached. 

 
Figure 46 - Coordinate System Settings  

3. Under OpenRoads Modeling or Survey, in the Terrain tab select the From File icon. 

 
Figure 47 - Import a Terrain Model From File  
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4. Browse to the downloaded LAS file(s) in Share / Oxford. Select the LAS file(s) 
885720_ne and 885720_nw and click on the Done button. 

 
Figure 48 - Select Files to Import Dialog Box 

5. On the Import Terrain Model(s) dialog box only leave only Ground checked on for both 
Terrains. In the file Option area select the Feature Definition Terrain\Existing Ground.  

 
Figure 49 - Terrain Items Selection 
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6. Under File Options the number of points and size of the file can be reduced by Filtering. 

Three options are supported: None, Tile, and Tin. From empirical studies, the tiling 

algorithm is faster and typically produces a 30% to 50% reduction in file size. The TIN 

algorithm typically produces a 70% to 90% reduction. 

 
Figure 50 - Three options to Filter the Terrain 

None  - No filter is applied if None is selected. No additional inputs are required. 

Tile - The tiling algorithm is a recursive divide and conquer algorithm that divides the 
data set into tiles. A best fit plane is calculated for each tile and points are removed if 
they fall within the user set Z tolerance to the plane. 

Z Tolerance The variation in the Z coordinate that the surface is allowed to move during the 
filtering process. Typically for the first invocation of the filtering function, the Z 
tolerance should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 
0.5 for metric data sets. Depending on the outcome and desired result, the Z 
tolerance can be varied up or down. 

Minimum 
Tile Points 

A tile will not be subdivided if it has less than this number of points. Typically 
set this to five. 

Max Tile 
Divisions 

Allowable level of recursion allowed and is the number of times the initial tiling 
set can be subdivided. Typically set this to five. 

Start Tile 
Length 

The data set is initially divided into tiles of this size, prior to recursion to the 
minimum tile points. The setting of this parameter requires some knowledge of 
the distance between the points, which requires an inspection of the points in 
MicroStation to determine. Typically set this to 10 times the distance between 
the points. 
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Tin - The TIN algorithm filters points if they fall within the user set Z tolerance of the triangle 

planes. The TIN algorithm first tiles the points into tiles with a maximum of 2 million points and 

then repetitively triangulates each tile filtering out points. 

Z Tolerance The variation in the Z coordinate that the surface is allowed to move during the 

filtering process. Typically for the first invocation of the filtering function, the Z 

tolerance should be set from 0.5 to 1.0 for imperial data sets and from 0.25 to 0.5 

for metric data sets. Depending on the outcome and desired result, the Z tolerance 

can be varied up or down. 

Granularity Course - Filters more points with some blurring of ridges and valleys. Fine - Filters 

fewer points with less blurring of ridges and valleys. 

Reinsert 

Points 

After filtering the points a further check is made based on the tolerances  

7. In the filter area select: 
Filter: Tin       Z Tolarence: 1    Granularity: Coarse 

8. Select Import and Close the dialog box. 

 
Figure 51 - Import Filter Settings 
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5.1.2 Graphical Display of Terrains 

1. Fit the View. Select the Element Selection tool. In the view left-click hold, drag a 
selection from the top left to the bottom right to encompass both Terrains.  Release 
Left-click.] 

 
Figure 52 - Terrain Selection 

 
2. In Properties turn on the Major Contours and Minor Contours. 

 
Figure 53 - Terrain Properties 
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Figure 54 - Contours on in View 
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5.1.3 Reference the LAS Terrain Model 

1. Open the File from Exercise 3.  
HW_CB_1234_1234_Oxford.dgn or SB_CB_1234_1234_Oxford.dgn 

Reference HW_CB_1234_1234 _Oxford_TerrainFromLAS.dgn in using Geograpghic - 
reprojected. Notice the reference lines up with the NAD 27 Survey File. 

 
Figure 55 - Attach Reference 

 
Figure 56 - References in View 
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2. On the Reference dialog box select Properties > Update Sequence. Use the arrow 
buttons to move the Active Design File to the bottom of the list, this will make this file 
show up on the top in the view.  Click OK. 

 
Figure 57 - Update Sequence 

 

 
Figure 58 - Updated Sequence in View 
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3. In Attributes on the Ribbon select the Clipping Boundary Level.  In filter enter tool, select 
the level TOOL_Clipping_Boundary.  Change the Color to Yellow and Weight to 10. 

 
Figure 59 - Set Color and Weight 

4. Using the regular MicroStation tool Place Shape, place a shape that will be used to clip 
out the un-needed portions of the terrains. 

 
Figure 60 - Place Shape Tool 

 
Figure 61 - Place Shape in View 



VOLUME 2 - Working with Existing Data 

42 
 

5. In the references dialog box select Tools > Clip Boundary.  Change the Method to 
Element and in the view select the Yellow Shape.  The Reference will now be clipped to 
the Shape. 

 
Figure 62 - Set Reference Clip Boundary 

 
Figure 63 - Reference Clip in View 
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6. Use the Element Selection tool to edit the Boundary: drag point handles, and add 
vertices as needed. Notice the Reference clip auto updates. 

 

 
Figure 64 - Add Vertices in View 

 

 
Figure 65 Drag Point Handles 

 
Figure 66 - Compare Clipping Before and After 



VOLUME 2 - Working with Existing Data 

44 
 

5.2 Terrain from ESRI 

This option is only available to users with a certain ESRI license. 

1. In CAD create Share / Oxford / HW_CB_1234_1234 _Oxford_TerrainFromEsri.dgn 

2. Turn on the View Background Map. Place a shape around the required LiDAR Data area. 

3. In the DGN file’s search field type in Esri Terrain, Sign in to ersi. 

4. A dialog box will appear, select the Feature Definition Terrain\Existing Ground. 

 
Figure 67 - Set the Existing Ground Feature Definition 

6. Follow the prompts and select the shape placed in step 3. 

7. Use the Element Selection Tool and select the new Terrain outer boundary. 

8. In the Properties Box, Calculated Features Display turn on the Major Contours and Minor 
Contours. 
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Exercise 6 – Connecting to GIS Data 
 
You can now display contextual data using the tools available in this workflow You can display 
data from different standard geospatial web services allowing to see the context of existing 
assets and data Feature Services Connections. 
Connecticut offers the open data that can be connected to, below is the link to the list 
https://services1.arcgis.com/FCaUeJ5SOVtImake/ArcGIS/rest/services 
 

In these exercises we will be using Feature Services in the Geospatial Context workflow . 

 
Figure 68 - Geospatial Workflow 

6.1 Connecting to a Feature Service 
The CTDOT DDE come with the following configured services.  In this section you will be walked 
through the step to connect to them 

1. Create a new file in the Share folder using NAD 83 / NAVD 88 and name it 
HW_CB_1234_1234_AADT.dgn  

2. In the View select Background Map and choose the Map Type Road. 

3. Zoom to the Downtown Hartford area. 

 
Figure 69 - View Window of Background Map 

https://services1.arcgis.com/FCaUeJ5SOVtImake/ArcGIS/rest/services
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4. Select Geospatial Context from the Quick Access Toolbar. In the Feature Services section select 

NEW. 

5. The New Feature Service Connection dialog box will appear select Services. 

 
Figure 70 - New Feature Service Connection 

6. Select AADT and click Close. 

 
Figure 71 - Feature Service Manager 

7. On the New Feature Service Connection click OK. 

 
Figure 72 - New Feature Service Connection 

8. On the New Feature Parameters, make sure AADT is checked Select Connect. 

 
Figure 73 - New Feature Service Connection Parameters 
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9. In the Feature Services section select Query Features 

10. It may take a few seconds for the data to load, click on one of the graphics and view the 
data. You may find it easier to turn off the Background Map. 

11. Click on the new purple lines and view the data in Properties. Notice the AADT Item box 
and review the fields 

 
Figure 74 - AADT Properties 

12. These query results are a snapshot in time, if some time has passed and you would like to 
view new results you will need to run the query again in this file. 
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6.2 Setting up a new Feature Service 

1. Create a new file in the Share folder using NAD 83 / NAVD 88 and name it 
HW_CB_1234_1234_Exsiting_Illumination.dgn  

2. In the View select Background Map and choose the Map Type Road. 

3. Zoom to the Downtown Hartford area. 

4. In the Feature Services section select New. 

5. The New Feature Service Connection dialog box will appear select Services 

 
Figure 75 - Feature Service Manager 

6. On the Feature Service manager click on Create Service Definition 

7. On the Create Service Definition paste in 
https://services1.arcgis.com/FCaUeJ5SOVtImake/ArcGIS/rest/services/CTDOT_Illumination
/FeatureServer 
and click in Connection Name, a name will auto fill, for Scope select WorkSet, click OK 

 
Figure 76 - Create Service Definition 

8. Click on the Connection name and select Close. 

https://services1.arcgis.com/FCaUeJ5SOVtImake/ArcGIS/rest/services/CTDOT_Illumination/FeatureServer
https://services1.arcgis.com/FCaUeJ5SOVtImake/ArcGIS/rest/services/CTDOT_Illumination/FeatureServer
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Figure 77 - Feature Service Manager 

9. On the New Feature Service Connection click OK. 

10. On the New Feature Parameters, make sure all options are checked Select Connect. 

 
Figure 78 - New Feature Service Connection Parameters 

11. In file explorer browse to your workset and notice the file 
\Standards\Data\FeatureServiceServerList.xml was created. This is because WorkSet 
was selected for Scope. 

12. Back in the CAD application select Edit feature Services. Only have the Illumination options 
toggled on. 
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Figure 79 - Edit Feature Service Connection Parameters 

13. In the Feature Services section select Query Features 

14. Click in the one on the new lines and points and review the data in Properties. 
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Exercise 7 – Skills Review 
This section is to be completed independently. Use the previous exercises as a guide. 

 
The following files will be used as the base data: 
Survey - These files use a Datum of NAV 1983 & NAVD 1929 and are old V8i files 
• Active_Survey\SV_XX_047_0122_Ellington_3.grn 
• Active_Survey\SV_XX_047_0122_Ellington_4.grn 
• Active_Survey\SV_XX_047_0122_Ellington_5.grn 
• Active_Survey\SV_XX_047_0122_Ellington_6.grn 
• Active_Survey\SV_XX_047_0122_Ellingtion_ORD_Terrain.dgn  

 

Rasters  and LAS Data- These files use a Datum of NAV 1983 & NAVD 1988 
• Share\Ellington\*.sid 
• Share\ Ellington\*.las 

Create three files: 
a. 2D Raster container file 

b. 3D LAS container file 

c. Design file that Geospatially matches the Survey Data and reference in the Raster and LAS 
Container Files, Survey Ground Files and Survey Terrain 

Discussion: 
1. What seed file did you use to create a? 

2. What seed file did you use to create b? 

3. What seed file did you use to create c? 

4. In File c. what steps did you take to line up the References of the old V8i Ground files? 

5. In File c. what steps did you take to line up the References of Raster Container? 
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Answers: 
1. What seed file did you use to create a?  

Organization\Seed\GCS\2D_NAD83FT_NAVD88.dgn 
 

2. What seed file did you use to create b?  
Organization\Seed\GCS\3D_NAD83FT_NAVD88.dgn 

 

3. What seed file did you use to create c? 
Organization\Seed\GCS\2D_NAD83FT_NAVD29.dgn 

 

4. In File c. what steps did you take to line up the References of the old V8i Ground files? 
• Orientation: Coincident World 
• In the References dialog box changed True Scale to off and the scale to 1 to 1 
 

6. In File c. what steps did you take to line up the References of Raster and LAS Containers? 
• Reference this file in using Geograpghic – reprojected 
• Reproject Elevations 
 

 
Figure 80 - Reference this file in using Geographic – reprojected 

 

     
Figure 81 - Reproject Elevations 
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Dataset Install for Self-Paced Training 
The training data set is stored in SharePoint for those doing self-paced training. 

1. In Microsoft Edge browse to:  DOT CTDOT_DDE - Training Datasets - All Documents 

2. Click on Training Data Sets and select Volume 2.  Click on the three dots … and select 
Download. 

 
Figure 82 - DDE SharePoint Page - Download Training Dataset 

3. CTDOT employees - In File Explorer under This PC browse to Downloads and copy the 
Active_Survey and Share folders to your Non-Project Work Area. 

C:\Users\yourname\OneDrive - State of Connecticut\CAD_NonProjects\Design\ 

Consultants or those who would like to work outside of one drive can create a working 
folder on their computer.  

4. When launching the application In CAD Accounting use the Non-Projects option for Run 
Program. 

 

https://ctgovexec.sharepoint.com/sites/DOTCTDOT_DDE/Training%20Datasets/Forms/AllItems.aspx?npsAction=createList&viewid=8f89c469%2D37fb%2D4ee2%2Da674%2D12cf04a332b6
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Revisions 
10/31/2024 

Volume Section # Description  
2  Complete rewrite Volume 2 - INTRODUCTION TO OPENROADS DESIGNER 

 
12/09/2024 

Volume Section # Description  

2  

Exercise 3, added Geographic Coordinate System Changed dialog box 
options descriptions, Reproject the Data to the Geographic Coordinate 
System vs Correcting the Geographic Coordinate System – do not 
reproject the data. 
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